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Geometry Update

Let’s hear about new capabilities within InRoads geometry.
In addition, let’s look at some capabilities within InRoads
geometry that may be new or puzzling to you.
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Updated Interface

e Implement tree view and grids for various
geometry view commands

— View Closed Areas

. . . w Stationin Data
o Generl | Dbzt | Prefie | Suffix | Frecision |Fomat | |
—_— Ie W a Ion Ing - % Regular Stations | [ Major Station 0 essms
 Cardinel Stations | [ Major Ticks ||
& Pls [ Submajor Statior 0 ssseas
- . 2 Station Equations [ 5ubmaar Ticks &
- View Station &Offset D R i — )
o Radised B Minor Ticks =]

E Werlical Stat
Gt ] Omit First and Last Paints

— View Curve Set | S

Left ffset: (.0 0o50 | (oo | oMo |

— View Vertical in Plan o i S5
& Data:
- - - i J [=c [AcEment e U TECIFION ormat arnE
- View Switch Height Plan AN e —

Fls E asting E= 0123

— View Turnouts

- Wertical Stations

Major Subrmsior Minor

[ Omit POB and POE [ Swap Point Abbreviation and Station
Display On: (&) Multiple Lines (2 Sinale Line

Leaders:
|bject  [Length  |Angle | Fislative To| Mame |
Leader Line Prop Horizontal

B2 Segment1 | 01000 100.0000 Alignment
[ Segment2 | 0.0050 | 0.0000 Alignment

e Consistency f =

e Enables the next step! ,
=1 Bentley
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A few more

{2l Curve Set Annotation Data

% Annolation Line
[ Paint
Teut I
[ Curve Number 1 1
[ Station 1 |2
L] Maorthing 1 3
[ Easting 1 Ik
[ Fiadius 1 5
[ Degree of Curve |1 4
[ Delts Lett 1 I3
Delta Right
[ A Length 1 |7
[ Spiral Length 1 g
[2 Constant 1 |9
< Superelevation 1 10

Sta | |n123
N= 0123
= J[XE=]
= m 01
De= | o1
<o (1 |
= |[m
le= | m 0123
L= |m 0123
= | JXE=]
D= mm |0

THESE5E

ddd "mm'ss. 55"
ddd"mmss. 55"

.50

BIED)

General JElb|ecl Column | Fow | Prefic [ Suffin | Precision | Format Marne
[

]

]

0 Station Offset Annotation
Genel

% Annotation

‘24 Vertical Change In Plan
© Generl
Symbol
% Mertical Pls
Tangents
Parabolas
Circular Curves

Data
| Dbject | Prefis | Suff | Precision  |Forrnst | Mame ]
Text
[ station Sta | 0123 sesssss
B4 Elevation Elev = 0123
[ 5ag Sag
[ Crest Ciest
[] Drop Station Equation Mame
Apply | [Preferences.] [ Cose | [ Hep |

Data:
J Object Column | Row Prefix | Suffis | Precision | Farmat MNanne J

Text e
[ Name 1 1
O Description 1 :
[ style il 3
Cd station |1 4 Sta 0123 sesssas
EBJ Ofiset Left |2 4 Lt mo 0123

Dffset Right Rt
[ Morthing 1 B N= 0123
[ Eastng 1 7 lE= | 0123
[ Elevation |1 ] El - 0123
Leaders:

|Ub|ect Length Angle Relative Ta Mame | |

Leader Line |
[ Segment1  0.0400 232323 From Alignment
[ Segment2  0.0050 g

=@ Yiew Closed Areas

2l View Closed Areas
General
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Data

JElb|ecl Prefix | Suffix | Precision | Name n]
Test

[ Name

[ Dessiption

[<] &rea in Square MEIEIS.AIEa =l am 0
[ fresinHectarss | Arsa= | hectsr: 01234

[ Permeterinbeters | Penmet m 0123
[ Ares in Squars Fest | | 0
[ Aveainfcres i
[ Perimeter in Fest o

[ teply | [Prefererces..] [ Close | [ Help
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And even some for rail users!

5 Switch Height Plan Mode: (O Plan () Plan and Diagrams () Chord Offeet Diagram
4 EEI’;‘E’&‘ Alignments
sttings
_ Hogvats Remeros: [ B #
i Turmauts Horizontal Alignment :l‘ﬂ
Date - Stalion Diagtatn
‘ Object | Prefis | Suftin | Precision | Fomat Marne ‘ ‘ E Profile Diagrarn D
Tameit ! f i~ Chord Offset Disgram Hare Desenpielt. | Stle
[ Recant Tumout 2 Lo Paints 2 Default
B In¥ertical Curve i) L . Subscripts 4 Default
2 Ot i 3 -
[ Dverlapping Tumout | | | i sz:a"
[ Mame & Description =] m2 Default
[ .1 Station | | 0123 |sesssss y m3 Defaul
ERE 7 .
O .0 Station 0123 s+3ssss . I
[ .0 Pairt {Z4 Switch Height Plan Data
[ .2 Paint | L General | Bbiect | Prefix_|Suifix_| Piecision |Fomat | Wame |
|:! 3Point m Lirita Seftings Wertical Lines
[ 54C Mose & Crossing - [IStation Horizaontals Subtangent Lines
[ Shunt Poirt Turnouts Left Rail Lines | ]
[ Eauivalert Radi | | 1 | [ | Station Diagram Right Rail Lines | ) I iE
' ) SLE [ Grade 6= 0123 A0
Chord Dffset Diagram = Length (= = 0123
Syrbalize Unbent Tumouts  [C] Symbelize Bent Tumaouts Points E Elevation B 0122
o St ; Hilsine B pgiedCant D= mm |0
1op Station E quation Names pplied Car | N 1
[ Cant Length L= m 0123
[ Cant Gradient m | 1]
[ Horizontal éis | 1 s+ssess
[ Vettical Axis 0

Frafile Set w4 [ ey

Bottamn Awis towithess Line Dffset |40 gpon [—]

Looier L Lot 10000 | Closs Auis Interval Plsn to Prcfile Disram Offset: |

eader Line Length: 10.0000 Horizontal: [100,0000 —————
Preferences... -;l Stioking Intersal !1 oo0n

[] Drop Station Equation Names

el EJ,PPUD | Wertical Exaggeration |T‘
Data ) : vt
| Dbject | Prefie | Suifix |Frecision |Fomat | Mame | =
[ witness Line turmaut i [ Apply ] [PIE’EIEHEES ] [ Close ] [ Help ]
[ Leader Line tnout
[ Mame hunout ]
[ Description | tumout =
[ .1 Station 10123 $+558.38
[ 2 Station (0123 sessss
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Updated Interface

e Implemented configurable list view
— Check Integrity
- Edit / Review Regression Points

T Stati. N E Dire. Moit, Easti.. | Directi.. IE R Co. Int.. In. | E.
Cl.. 0+100.2... 4640.. 2117, 260063 464199, 211754, 226660 109.0. 321.09..0K Ok 0K
Cl.. 0+209.9. 4641.. 2117, 22 5560, 464266, .. 211700.... 241262 73.53. 33.09..
Cir.. 0+203.4... 4642, 2117... 241262464400, 211840.... 30.3104 .
Cl. 0+428.2. 4644, 2118303104 464478 211883..32.2093 8893
Lin._ 0+517.1.. 4644, 2118322093 464523 211907.... 32.2093
Cl. 0+667.9. 4645, 2113 322093 464603 . 2115954..30.3197 981
Cir.. O+6E6.1.. 4646.. 2113 303157 464674 2115986275330 721
Cl. 0+738.3. 4646.. 2119.. 27.5390. . 464771... 21202%... 25.4994 1059 | Twps | Ststion @Statt | Length PRadius | Integrity & Integrity Elem Apply
Lin..0+244.2. 4647, 2120, 264994 4EE997. . 21296E... 20,4934  2407) 1 1
Cl.. 3+251.2. 4669..2129.. 25,4334 467097, 213010... 21.7024 1178 |Clathoid 0+1008873 109.0164 oK QK.
Cir... 3+369.1... 4670... 2130... 217024, 467730, 213020.... 380,733 6449 | Clathoid 0+209.9037 735363 0K Ok
Cl. 4+0138. 46772130 380173 467822 212986 377.0166 98.0Y Cicular 0+283 4400 144 8124 1490.732 0K oK
Lin._ 4+111.8. 4678, 2129 377.016. 460757, 212256, 3770166 2068 | Clothoid 0+428.2524 §8.9300 oK oK
Linear  0+517.1824 60.8172 Ok 0K
Clothoid  0+5E7.9397 981147 Ok 0K
Circular  0+666.1144 721832 -1652.74... 0K 0K
Clothoid - 0+738. 3036 105.9014 Ok QK.
Lingar  0+844.2050 2407.0106 oK oK
Clathoid 3+251.2155 117.8508 oK aK .
Circular - 3+363.1064 6447085 -588.305.. OK. oK S
Clothoid - 4+013.8143 98.0123 Ok oK
it S Linear  4+111.8271 20681706 oK
News | [ Le [ A ] |
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Regression Points:

Mame Inchude in Analysis

T T X
=
a
2

&
<
¥
i

Status
Hormal
Mormal
Marmal
Narmal
Mormal
MNormal
Mormal
Mormal

[y}

J [

Insert, Edit

J {

4
— [ selsctOn
Select & Regress
| Help
Delte | !
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Explorer

e View All

— Horizontal alignments
— Turnouts (rail only)
- Rails, Joints & Keepers (rail only)

e Hilite
e Fit & Hilite

o <Ctrl> Active
— Set an alignment active by selecting the graphics

o <Ctrl> Delete
- Delete an alignment by selecting the graphics

= Bentley
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Horizontal Curve Set Commands

e If you can create it with the curve set
commands then you can edit it with the same

— Primarily aimed at Move PI & Insert PI and SCSCS
curve—ts N

= Bentley
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AREMA Transition Spiral

e Chord definition

e Simple & compound
— Available in Bentley Rail Track!

Elenent: AREMA
TS

)] 3+37.1050 101914712 10277 4501
SPI )] 5+37.0953 10305 .0631 10442 0496
SCO )] 6+37.1050 10357 .5103 10527 2682
Entrance Radius: 0.oooo
Exit Radius: 2864.9344
Length: apo.ooon
Angle: 3°00'00.0" Right
Constant : 927.081¢6
Long Tangent: 199.9902
Short Tangent : 100.0646
Long Chord: 299 9634
Es: 2999177
Ts: 5.2370
P 1.3107
K: 149 9786
Tangent Direction: N 55°23'24.1" E
Radial Direction: S 34736'35.9" E
Chord Direction: N 56°23'25.4" E
Radial Direction: S 31736'35.9" E
Tangent Direction: N 58"23'24.1" E
Elenent: Circular
SC0 )] E+37.1050 10357 5103 10527 2682
PI [ )] 10+99.8233 10600.0368 10921 3357
CC )] 7917 6297 12025 8778
CE )] 15+54 5718 10706 1755 11371 7164
Radius: 2864 .9344
De=sign Spesedi{mph): 70.0000
Cant {inches): 5
Delta: 18720'57.6" Right
Degree of Curvature(Chord): 2*00'00.0"
Length: 917 5133
Length{Chorded) : 917 4667
Tangent : 462 .7183
Chord: 913.5973
Middle Ordinate: 366515
External : 37,1265
Tangent Direction: N 58°23'24.1" E
Radial Direction: S 31736'35.9" E
Chord Direction: N 67733'52.9" E
Radial Direction: S 13715'38.3" E
Tangent Direction: H 76744'21.7" E

= Bentley
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.
Table Editors

e Simpler editing
- No discontinuities, no compound curve sets

e We now honor the Tools > Options > Geometry
— Define Transitions By Length or Constant
— Spiral Definition Clothoid, AREMA, Bloss, etc.
- Undocumented Tip - <Ctrl> right click

Curve Sets:
Marthing | Easting | Leading Trangition | R adiug
E775751.0340 15435594 4920
7741504603 1545691.4024  0.0000 5000.0000 S
B777638.0489 | 1556513.4831 1 200.0000 | 2000.0000 ]
£781103.5656 1552165.5775 200.0000 2000.0000 — 3
B706738.9959 15517960573 | il Utida
’ ’ : ’ Station | Elesation | Length |
100000000 20,0000
12+000.0000 40.0000 1000.0000
18+000.0000 5.0000 1000.0000
24+000.0000 10,0000 1000.0000
30+000.0000 | 70.0000 1000.0000
32+000.0000 50.0000

= Bentley
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Vertical Alignment Healing

e An attempt to synchronize / update the vertical
alignment when the horizontal alignment has
changed.

— The coordinate position of vertical PI's will be held!
- New in 'Athens’

= Bentley
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Edit Horizontal Element

e Component Editor type of functionality

e Maintain Element Connectivity with Minimum

Movement it Horizont! e EE)
Define From: (33 Stat () Stop () Both
— Previous element is freed e e 2
. . Transpose
— Current element is fixed o
u Paint Wame: ,—l m
- Next element is freed s [ +
casis
Direction: ﬂ
 ——
Stop
[osism ]
[ ]
I—I Select
ESCETERNE N | g
awmre ] 4]
oo ]+
Length: W‘ﬂ [T]
taintain Element Connectivity
[ Maintain Element Connec tivity with Minimun kovemen t

= Bentley
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Multiple Element Connection Editors

e Edit beginning and ending elements
— Change radii / direction

e Inclusion of cant (rail only)

Main | Advanced_?

Beginning Element s
Type Free Length R adiuz
Circular [0 [soo.0000 | [1oooooo0 | [ Selest |
Applied Cant [rmm]: !m_gggg |
Connecting Element:
Tupe Free  Length Free | Parameter T.. Applie.
iernese [l 300.0000 B47.7226 [ |
Circular [ 397.9330 ] -500.0000 140.0000
Wisrnese [] 300.0000 387.2983 O
Linear [ 991.4106 M gMo429'e [
Wiennese [ 300.0000 387.2983 ]
Delete
Impart...
Ending Element
Type Free Length Radiuz
Circulsr O [4325084 | (5000000 | [ select |
Applied Cant [mm): (140 0000 |
chifr
[ Apply ] [ Save ] [ Save Az, ] [ Cloze
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Edit / Review Extended Descriptions

e Adding non-graphical data to the design data
- Extending the data with long textual descriptions
e Persisted with the .alg
- Extending the data with an external file / digital images

=8|

gre) v AR § Cllal] A W EIGH &9 R G
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Cogo Audit Trail Lock

e Similar to the Report Lock for cogo commands,
but independent!

— Writes a .aftf file to the same folder as the active

geometry file.

| WWW.BENTLEY.COM

B scratch.atf - Notepad
Fle Edb Formab biew Help

W

Inverse pirection

I
woow wodified by Richard.Bradshaw on 10/28/2008 9:04:26 Am
etk

11318.4793 3839.8636 0. 0000
N 50456'10.4" w 161.1038
11420.0045 5714.7774 0. 0000
Inverse Direction
11420.0045 5714.7774 0. 0000
N 14459'34.5" E 96. B6ZE
11513.5699 5739.8358 0. 0000
Inverse pirection
11513. 5699 5739.8358 0. 0000
N L1LASL'42.8" W F0.5753
11582. 6381 5725.3289 0. 0000
Inverse pirection
11582.638L 5725.3289 0. 0000
N 54423'17.3" E 98. 7800
11640.1568 5805.6351 0. 0000
Inverse Direction
116440.1568 G805.6351 0. 0000
N B9A32'11.5" E 113.3143
11641.0734 5918.9456 0.0000
Inverse Direction
11641, 0734 5918.9456 0. 0000
5 10403'10.2" w 128.4967
115145495 5806.5158 0. 0000
Inverse pirection
11514, 5455 5896, 5158 0. 0000
5 TSA0'03.T" w 124.6252
11483. 64591 5775.7694 0. 0000
Direction Traverse
Mode: Add to Cogo Buffer
1128%.41594 5808. 5186 0. 0000
N 35400'00.0" E 100. 0000
11371.3346 5865.8763 0. 0000
N 60A00'00.0" E 100.0000
60 11421.3346 5052.4788 0. 0000
Direction Traverse
Mode: Radial
6 11421.3346 5952.4788 0. 0000
M 75400'00.0" E 99,0000
a1 11446.9577 A048.1055 0. 0000
Direction Traverse
Mode: Radial
80 11421.3346 3852.4738 0. 0000
N B0A00'00.0" E 45.0000
62 11423.1488 3896.7951 0. 0000
Diraction Traverse
Mode: Radial
60 11421 .3346 5952.4788 0. 0000
S 44400'00.0" E 47,0000
63 11387.5256 5885.1277 0. 0000
Direction Traverse
Mode: Add to Cogo Buffer
a0 11421.3346 5852.4738 0. 0000
S B0A0D'00.0" E 200. 0000
a4 11369.240L1 6247.9211 0. 0000
tn 1, Coll
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Design Checks

e Not just warnings!

- Now it indicates that the geometry is acceptable!

Design Checks

| Darishfiai | DuchPail | GemanFal | Transiopid | Interactive |
General Foads | CEN Standards |

I
Default L|
Horizontal Alignment: | oty Road 1534 ;] _—&J

Wertical Alignment: | ;_| jJ T

Austrian B ail

|

Type: |

Geometry Project:

Include Children

Definition: () Single Classification (%) Multiple Classifications

Classification File: id:\data\design checking. bat i

Design Criteria File: ibentley\inroad"‘l J1hdataimpernial\Design Criteria. tst

[ Freferences... ] [ Cloze

| WWW.BENTLEY.COM

Checking stopping sight distances for alignment 'pefault’
104550.0000

Classification: G5-1M Freeway Terrain: Rolling Speed: &0
warning: pesirable minimum stoﬁping sight distance exceeded!
pesirable minimum stopping sight distance: 205.0000
pesirable minimum Jength shouTd be: 499,1020

Actual Tength: 300.0000

11+050.0000
Classification: GS-1M Freeway Terrain: Rolling Speed: &0

Acceptable: actual Tength is greater than desirable minimum stopping sight distance.

pesirable minimum stopping sight distance: 205.0000
Actual Tength: 300.0000

Alighment:

| Default
Start Station: | 127+00.0000
Stop Station: |185+1 9.1564

[ o

Canicel

Classification: |GS-3M 1500 < ADT < 2000 b

Temain:

[Raling |
Design Speedt | 5 v
i
| Alignment Start 5t... Stop 5t... Classification Tz || 255
EDef 0+

ALk
Ak ; 5 i

Country Roa... 10+00.000... 26+86.823... G5-4M 50 < AD...Rollin... 30

Country Roa... 10+00.000... 37+65.007... G5-4M 50 < AD... Rollin.. 30
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Rail Related Geometry Enhancements

e Quick Regression
e Integrated Horizontal & Cant / Superelevation

e Turnouts
— Inclusion of railway standards
— Creation / editing enhancements

e Field to Design / Design to Field
— Machine to design / Design to machine

o See Bentley Rail Design Update for complete
details!

= Bentley
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Tips

Useful things that you may not be aware of!

= Bentley




Tip #1: How to clone list view settings?

= My Compuker
+- D HEEY _CLASSES_ROOT

c2!
(2] HKEY_CURREMT_USER
-] HKEY_LOCAL_MACHINE
HEKEY_USERS
{7 .DEFALLT
£ 515-18
£ 51519
7 51-5-19_Classes
£ s-1-5-20
£ 5-1-5-20_Classes
D 5-1-5-21-953463015-192451 2962-251 9238931 -3555
(23 {rully
-2 AppEvents
[ console
-2 Control Panel
i |:| Enviranment
(23 1dentities
{23 Keyboard Layout
-2 Printers
[I SessionInfaormation
=2 software
[ Adobe

Alkova

Analog Devices
ATI Technologies Inc,
Autodesk

=3 applications
=+ Version .11
-2 DefaultPaths

i |_] RewewHorlzontaIRegressmnCqumns
ez {27 railapp.di
(11 ReloadonPrefersncechangs
=} (2 TextScalealert
{0 Annotate Cross Sections
(] Annotate Profile
-2 Toolbars
S e
E:l Curfpp
(23 Help
|3 InRoads Survey
E:l ListWiewSettings
] E:l ReportBrowser
i E:l RoadwayDesignerSettings

| WWW.BENTLEY.COM

styiews.reg - Notepad
File Edit Format Wiew Help

windows Registry Editor version 5.00
[HKEY _USERS%S-1-5-21-953463015-1924512962-2519238931-3888 sof tware’Bent 1 ey InRoadsGrouphapp”
[HKEY USERSYS-1-5-21-0534453015 -1924512562-2515238531 - 3888 software Bent leyhInRoadsGrouphapp™

"CheckIntegrity0'="Type; Type;1;0;38"

"CheckIntegrityl station @& Start station @ start;l;l;44"
"CheckIntegrity2 Narthing @ Start Morthing @ start;l;2; 51"
"CheckIntegritys Easting @ sStart; East1ng 8 SEanEylsas Rl
"CheckIntegrityd Direction @ Start Direction @ Start 1;4;66"
"CheckIntegritys Narthing @ End; North1ng @ End; 0;-1; a2
"CheckIntegritys Easting @ End; East1ng & End; 0; 62“
"CheckIntegrity? pirection @ End D1recti0n 3 End;O;—l;?S“
"CheckIntegrity8"="Length;Length;1;5;44"

"CheckIntegritys Radius; Radius;1;6;:44"

"CheckIntegritylo' Constant Constant 0;-1;55"
"CheckIntegrityll' Integr1ty @ start; Integr1ty @ Start 1;7;44"
"CheckIntegrityl2"="Integrity @ End; Integr1ty @ End;1 44

"CheckIntegrityl3"="E]emant Integmty, Element Integr1ty,l,9,44

[HKEY USERS%5-1-5-21-953463015-1924512962~ 2519238931 3a88 softwarehBent ley\InRoadsGrouphapp”
"RewiewHorizontalRegression0'="Name; Name;1;0; 68"

"ReviewHorizontalRegressionl’ North1ng NDrth1ng;0;—1;?2
"ReviewHorizontalRegression2”="Easting;Easting; 0;-1;72"
"RewviewHorizontalRegressions'="style; St¥1e Toxi T2 65"

"RewiewHorizontalRegressiond’ Include 3n Ana1ys1s Include in Analysis;l;2;68"
"RewiewHorizontalRegressions'="Status; status;1;3; 68"
"ReviewHorizontalRegressiong"="0ffset;offset; 0; 1 72"

8 A | ?

Ln 1, Col 1

= Bentley
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Tip #2: Multi-Center Curve

Wain | Advanced|

|-Ma\n | Advanced |

CveTe: [TheoConter ]
Radii
Fiadius 1: \widihs
Fiadius 2: “wfidth 1: | noo |ij
Fradius 3: width |ﬂ
Define By

(%) Dffgets at Shifted PC/PT (O Offsets at PCC/PCC (O Length

Alignment

Name |Rieturr 1 i
Description, |
Siyle: ! Default w |

Create Yertical Alignment

First Selected Alignment
(Vertical Distance:

(@) Gradient: 200003
Offeet 1: 7 Surface :
Offset 2:
Second Selected Alignment
Exsinle () Wertical Digtance: J
] (&) Gradient: 2 0000 '|
................. - -
i O Surface, xtah
| ———
i Length to Extend Ends: 10,0000 ]
o
£l
§i
|
'
I
I
'
-
bzt
Apply ] [ Preferences... ] [ Cloze ] Apply ] [ Preferences... ] [ Cloze

e Creates horizontal & optionally vertical geometry
for 1, 2 & 3 center curves
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Multi-Center Curve: Horizontal Geometry

e Horizontal

= Bentley
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Multi-Center Curve: Vertical Geometry

e 2% cross-slope from mainline for 12’

e Tangential slope at PVC

= Bentley
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But what if in a transition?

e Create a surface with Roadway Designer and use
it in Multi-Center Curve for the vertical
geometry.

- Almost the same computations, except

e Elevation at PC and PT are from the surface

e Tangential slopes at PC and PT are from the surface

— Compute an elevation slightly before the PC and slightly
after the PC

— Likewise for the PT

= Bentley
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Tip #3: How to annotate features?

e File > Import > Geometry from Graphics
- Import features as a horizontal & vertical alignment

e Geometry > View > Station Offset Annotation
- Set method to Station Offset

- Set from as baseline AR AL
;_'!,] Station Offset Annotation | Methodt | Station Offset I Filker..
- QE EEEEE I_ From Inzlude
— Settom po rte eature T e
] Event Paints
. .
— Set stationin :
Mode: (@) dlignments it
. Armiotate left ditch | ]
- Set interval
Mame [rescription Style
left ditch Default Interval (500000 fi{
Limits
[¥] Station
Start. [10000.0000 | #]
Stop. [1zavaoood | 4]
Apply ] [F’ref eeeeeee ] [ Cloge ] [ Help ]

= Bentley
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[
Tip #4: How to import textual data?

e Text Import Wizard
— Horizontal as curve-sets
— Vertical as curve-sets

- Horizontal & vertical events
e More in a moment!

- Cogo

— Regression points
e Data must be in order

e Bypasses data checking available in Regression > Add Regression
Points

e Wizards are persisted to the XIN

= Bentley
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port Wizard - Step 2 of 4

Original Data Type:
() Fived \Width - Fields are aligned in colurns

Apply Filter to
) &l Lines

@ Lines that Start with: 50
O Lines that leluds |

| (%) Delimited - Characters separate each field

| Defined Filters:
() Seaments of Text

| Name Description
Siat | | | il
- i Include N...Include lines that start with 'M+E*

End) | |
[ Exclude Fitered Lines From lmport

D:\Documents and Settings\Richard Bradshaw\My Documentshtin events bt
Er 100000000 0.0000  10215.3%08 45711042 0.0000 Default »| [k
340 10200.0000  ©0.0000  1018%.2812 avz4.2532 0.0000 Default E
240 10900.0000  ©0.0000  10064.506% 4351.2536 0.0000 Default =
40 10600.0000  ©.0000 28616523 s052.6530 0.0000 Default d
540 10800_0000 00000 28326001 52266052 0.0000 Dafanlc
£ 11000.0000  6.0000 28318789 5423 6326 0.0000 Dafanle
£ 11200.0000  0.0000 28075122 56278800 0.0000 Dafanle
540 11s00.0000  ©0.0000 a80e_ 5072 58279075 0.0000 Default 9|
Open... ] l Save ] [ Save As. ] l ¢ Back ] [ Mewt > ] [ Firish ] [ Cancel J
D:ADocuments and Settings\Richard. Bradshaw\My Documentsitiv events bt
Sip S . skip Skip Skip Sip Al
s+ 10000_0000 00000 103165388 4571.1443 0_0000 Defanls
s+ 10z00_0000 00000 101852812 4724.3832 0_0000 Defanls
£ 10400_0000  0.0000 100646088 4831.3859% 0_o000 Defanle ||
540 10500_0000  0.0000 39616523 s052_6533 0_0000 Defanlt
340 l0s00.0000  ©.0008 3692.6001 52366052 0.0000 Default
340 11000.0000  0.0000 3631.8784 54296226 0.0000 Default
240 112000000 0.0000 2807.5122 5627.9503 0.0000 Defaulr
B 11400.0000  0.0000 38025073 5527.9078 0.0000 Defauln el
Open.. | [ Save ][ Savess. | [ <Back | [ Mews ][ Fish | [ Concel
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Text

nport Wizard - Step 2 of 4

Apply Filter to
1Al Lines

(@ Lines that Start with:  [nag |
() Lines that Include ‘
) Seaments of Text

Mame: Description
Stait | | Include 5. Include lines that st
- — |

i
I
Encl | |
[ Exclude Fitered Lines From |mport

Orignal Data Type:
() Fived Width - Fields are aligned in columns

| Defined Filters:

(%) Delimited - Characters separate each fisld

art with 'S+0"

[r\Documents and SettingsiRichard Bradshawhiy Documentshtive events bt

S+E & N+E Events from a Single .txt

100000000 00000 102169255 2571.1492 0.0000 Dafanlt A!
L0150 0000 00000 L0ZZ0. 5206 4E5E6.0510 0.0000 Defanle ‘
10500.0000  0.0000  10010.1540 43652087 0.0000 Defanic
10850 0000 0_0000 A86& 1501 52&3.1557 0.0000 Defanls @
11z00.0000  0.0000 98075122 5627.9300 0.0000 Defanlt
11550 0000 00000 2799 5835 597768497 0.0000 Default ‘
11s00.0000  0.0000 97327611 327.8214 0.0000 Defanlt
122500000 00000 4778117 BETT. 2450 0.0000 Defanlt |
|
[ Open... ] [ Save ] [ Save ds. ] [ < Back ] [ Mext > ] [ Finish ] [ Cancel ]
D:\Documents and Settings'Fichard Bradshawiby Documentshties events. bt
Skip Skip Skeip Worthing East ing Skip Skip |
F+E L0000 . 0000 00000 [LO0216. 9358 4571.14942 0.0000 Dafault ‘
F+E L0150, 0000 00000 [10Z20. 5208 46560510 0.0000 Default
BT 10500.0000  0.0000 hooto 1540 |4985.2097  o.0000 Defaule
T 10350.0000  0.0000 lbess 1501 |s234.1557  0.0000 Dafaule
wE 11200.0000  6._oooo lbso7 5122 |sez7.ases  0.ono Dekault =
WE 11550.0000  0.0000 lo7sa.ss9s  |se7r.887  0.0000 Default
WE 11z00.0000  0.0000 lb7sz.7811  |sazr.s3la 0.0000 Dafault
K+E 12250.0000 00000 [#778.1777 GERT. 2484 noannn TimFanle sl
- fe | Station Offset Marthing
M... 11900.0000 0.0000 9733.7811
Open. | [ sove ][ seese ][ <Bok [y iisspmoo0  qooo0  Srasesss
... 11200.0000 0.0000 98075122
... 10850.0000 -0.00000  9868.1501
.. 10500.0000 0.0000 10010.1540
10150.0000 -0.0000.  10220.5206
. 13375.0000 0.0000 9315.4313
13200.0000 0.0000 9405.5630
. 13000.0000 0.0000 95085706
. 12600.0000 0.0000 9610.2712
. 12600.0000 0.0000 9634.7156
12400.0000 0.0000 9753.1424
. 122000000 0.0000 5784.4033

E azting Elewation . Stle
E327.8314  0.0000
54977.8847  0.0000
5627.3803  0.0000
52841557  0.0000
4965.2097  0.0000
4686.0510.  0.0000
TEI0.8E56  0.0000
7h40.8613  0.0000
73694273 0.0000
7197.2283  0.0000
70161082 0.0000
E826.0026  0.0000
BE27.6253  0.0000
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[
Tip#5: Inversing

e Display and Annotate check box

- Set on and you get lines and annotation based upon
geometry style

- Set off and you don’t get the line and annotation

e
Preferences ] [ Close ] irerse ] Radial .Tangent foset"i Annctate | :

[ Digplay and Arnatate
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[
Tip #6: Annotating MicroStation Graphics

o Utilizes geometry “styles” to annotate
MicroStation lines, linestrings & circular arcs
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[
Tip#7: Chord definition settings

e Arc / chord definition is persisted with the
alignment

- No you can not mix arc and chord in the same
alignment!

- We persist the radius not the degree of curve

e Other system settings are in the preference file,
accessible from Tools > Options > Geometry

= Bentley
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Tip #8: Alpha-numeric cogo points

e Graphical commands have always supported
alpha-numeric points names.

— Cogo Classic / Import ICS have never supported alpha-
numeric point or alignment naming!

e What about Geometry > Utilities > Create / Edit
Alignment by Cogo Points?

- Emulates ICS, so the answer should be no, but it is
yes!

= Bentley
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Alpha-numeric cogo points

e Variable Manager ol —
- Lots of other options! - ECwmm—.

epl01 <CPL» ep102 ep103 <CPL> ep104 epl05 <CPL>
epl06 ep107

& Variable Manager

C_ommand Behaviar: it Apply

File - Perzist Project Default Paths
File - Ormit Project Optians Full Path

[ ]|5uitace - Dizable Highlight for Random Features i
: Geomety - Dizable Cogo Points in Explorer HNarme: |F|etu|n il i ‘ j‘J [ Apply ]
Z Geomety - &llow saving disconnected solutions Dieseriptian: '—]

[ |Geomety - Omit Sight Distance from Vertical Review e —— Closs

Stile Defaul v| ree )
; Survey - Dizable Survey Points in Explarer Gkl ) . '
[ |5urvey - Use Spaces in Surface and Geomety Description £ Alighment Definition:
: Survey - Exclude Generated Paints from the Coga Buffer 27 C28L 29 C30L 31 C32L 33
: Survey - Create a Duplicate Point for Out-of-Order Points
: Survey - Honor Surface Wertical Scale for Digplay
[ |Evaluation - Enable Left and Right Shoulder Slope Staking
Ewaluation - Slope Stake Report in Crass Section Annotation
Toals - Simultanecus Tracking
Custamer-specific: |

H

Diescription

Enables alphanumeric point names in the Geometmy > Utilties » Create/E dit dlignment by Cogo
Pairts command.

Graphical [nput

Eurve Midpoint
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And while we are on Tools!

o Application Add-ins now only show the available
add-ins for the running product

[ Jhctive Project Settings Add-n ~

[ CEAL Translator ddin S
: Compare Surface Add-In
: Copy Preference Add-In

D Translator Add

|| Display Superslevation in Plan Add-n
[ ] Display Suface Addin
Drrawe Slope Direction Pattemn Addn
Drive Roadway Add-n
E=port Leica DEX 1200 Add-In
Find Near Paints Add-n
Generate Grade Contour Add-n it
GENIO Translator Add-ln
Global Scale Factors Add-n
Graphics Translator AddHn
Z Horizontal and Yertical Elements &dd-n
[ |Hydrology and Hydraulics &dd-in
Impart AMSA Add-In
Impart LAS AddHn
Impart SAY Add-In
Impart Subsurface Add-In
1Lk st elebin ]

Description
The Design Checks Add-n includes crteria which are uzed in design formulas
whenever the Design Checks Lock is luned on while using alignment design
commands.

Cammmand ) )
Geometny: Utilities: Design Checks...
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Questions?

4 Bentley

| WWW.BENTLEY.COM




